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WELCOME to eForms Wizard!  Our goal with this Setup Guide is to get you and your 
team up and running quickly with this powerful software.  By implementing this tool as 
your first point of data capture at the point of sale, you will increase your efficiency and 
get complete and accurate submissions to market faster.   Let’s get started! 
 
Following this Setup Guide will help you save keystrokes and duplicate entry right from 
the start. 
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Download and Install eForms Wizard 
 

From your Welcome Email 
Each eForms Wizard subscriber is emailed a “Welcome” email which includes their unique installation 

URL as well as additional resources and help information. This “Welcome” email is how most new users 

in an agency or additional users to an agency’s eForms Wizard subscription start out. The link will take 

you to the AVYST portal and allows you to set a password and activate your account.  From there, you 

can download and then install your eForms Wizard software.  If using the link in the “Welcome” email, 

you will find there are some brief instructions for you to follow.  The process is further outlined on pages  

4/5. 

When you click the unique URL provided in your Welcome Email, you will: 

• be directed to the AVYST Portal Welcome Page  

• be prompted to create your AVYST Portal Account Password (you will need this if you wish to 

install your software on another machine – like a laptop or table - or if you get a new computer) 

• Login and Download (per the instructions onscreen and as noted on pages 4/5) 
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From the AVYST Portal 
If you don’t have this email handy, you can simply go to the AVYST portal at  https://portal.avyst.com 

and use the “Forgot password?” link at the bottom of the screen.  Enter the email address you have on 

file with AVYST and you will be sent an email link to reset your password.  Once you’ve reset your 

Password, log into the AVYST portal. 
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Activate eForms Wizard Software 
Once you’ve logged into the AVYST portal, you will have access to Download your software.  Select the 

“Downloads” tile. 

 

From the Downloads area of the screen, select the Download button. 

NOTE:  If you are the Subscription Owner or Administrator for your organization’s account, you 

may see multiple usernames listed.  Be sure to highlight the correct name / email line before 

clicking the Download button. 
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Follow the Installation Instructions on Screen to continue with the download process. 

NOTE:  When the eForms Wizard download completes, the installation typically starts 

automatically. Once installation is complete, eForms Wizard should open automatically. Because 

this is the first time you are opening eForms Wizard, you will be prompted for your credentials. 

The license key you are being asked for, can be found in the onscreen instructions displayed 

when you originally selected download. You must use CTRL+C to copy the license key and then 

you can use your mouse or CTRL+V to paste the license key into the corresponding field in 

eForms Wizard – do not attempt to manually type the license key.  (see screen shot on next 

page) 

 

 

NOTE:  There is a chance that if you do not have administrative rights to your local 

PC/laptop/tablet PC you may need the assistance of someone who does.  Your device will ask if 

you want to allow AVYST/eForms Wizard to make a change to your machine. If you have 

administrative rights to your machine, this will be as simple as clicking YES or NO when the 

window with the question appears. If not, the window will ask for user and password for the 

installation to finish.  If you don’t have this information, you’ll have to seek the person who 

does. 

NOTE: There is also a chance that your anti-virus or firewall may interfere with the download 

and/or installation of eForms Wizard.  If that happens, one or both will need to be temporarily 

disabled in order to complete the installation process; after which you can re-enable these 

security items.   
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The eForms Wizard software download and installation process should take no more than 10-15 

minutes on average. Once your software has been successfully installed, the AVYST icon will appear on 

your computer’s desktop.  Double-click to launch eForms Wizard. 

 

 

Set up your Agency / Agency Branch Offices 
To save keystrokes over the long run, take a few minutes to enter your Agency Information, including 

Branch Offices.  While each user can choose to set up their own Agency / Branch information, in 

organizations with multiple eForms Wizard subscribers, we recommend having one person add all the 

agency and branch office details.  Setup information can then be shared with others using the “Export 

Setup” link.  The recipient of the setup file will use the “Import Setup” link. 

• Choose the Setup tab.   

• Open the Agency Information screen. 

• Select “Add Agency” and enter the requested information. 

• Select “Submit”. 

• In the GOLD Subscription, you can add multiple “Agency” entries.  We recommend adding each 

agency location / branch office. 

o NOTE:  Each User may “Set default” based on their preference. 
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Set up Producers and Assign them to the Appropriate Office 
To save keystrokes over the long run, take a few minutes to enter Producer Information.  While each 

user can choose to set up their own Producer information, in organizations with multiple eForms Wizard 

subscribers, we recommend having one person add all the Producer details.  Setup information can then 

be shared with others using the “Export Setup” link.  The recipient of the setup file will use the “Import 

Setup” link. 

• Choose the Setup tab.   

• Open the Producer Information screen. 

• Select “Add Producer” and enter the requested information. 

o NOTE:  Producers are required to be attached to an Agency.  If a Producer works out of 

multiple offices, add them multiple times – once for each office.  

• Select “Submit”. 

• In the GOLD Subscription, you can add multiple “Producer” entries.   

o NOTE:  Each User may “Set default” based on their preference. 
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Set up your Carrier NAIC codes 
To save keystrokes over the long run, take a few minutes to enter your primary Carriers and their NAIC 

Codes.  While each user can choose to set up their own Carrier information, in organizations with 

multiple eForms Wizard subscribers, we recommend having one person add Carrier details.  Setup 

information can then be shared with others using the “Export Setup” link.  The recipient of the setup file 

will use the “Import Setup” link. 

• Choose the Setup tab.   

• Open the Carrier Information screen. 

• Select “Add Carrier” and enter the requested information. 

o NOTE:  Defaults can be selected by User. 

• Select “Submit”. 

 
NOTE:  Adding your carriers is not as vital as adding your agency, branch office and producer 
information. From a pure New Business submissions perspective, many agencies leave the Carrier field 
blank on ACORD forms to make submitting the same ACORD forms to various carriers simpler. 
However, for renewal submissions, certificates, binders, etc. you may want to have a table of carrier 
names to choose from within each respective form.  Also, for integration purposes, this may become a 
more important field in the future. 
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Configure Options 
eForms Wizard enables users to configure various features and functionality of the software. 

• Choose the Setup tab.   

• Choose the Configure Options icon. 

• Folder Locations: 

o NOTE:  Folder Locations default to the local drive of the machine the software is 

installed on.  Many users prefer to set up a shared location as an additional place to 

save Client Folders. 

o Save as / Export Folder – this is the default location for files that are 

saved using the “Save as / Export” dropdown list. 

o Client Folders Location – this is where a shared or network drive 

location would be selected.  This should allow the user’s work to be 

saved on a local drive that then will sync with a network or cloud folder once the user is 

connected to the network or internet. 

o AL3 Folder Location – this is the location where any AL3 export data would be saved. 

▪ NOTE:  This comes into play with integration between eForms Wizard and other 

solutions. 

o User Packages Folder – this is the storage location for Custom Packages created by 

users.  (See the section entitled “Creating Custom Packages for Your Agency”). 

• Form Options 

o We recommend leaving the defaults, but should you wish to change how the forms 

appear or behave within the software, you can adjust these settings by individual user. 

▪ NOTE:  Many users find it helpful to change the Form Tabs Display to “File 

Name” for ease of knowing which company forms they have included in their 

Client Folders. 

• Colors 

o Select field colors for Errors, Display of fields as you work through a form, and Printing. 
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Share / Export / Import Setup  
In organizations with multiple eForms Wizard subscribers, we recommend having one person add the 

various Setup details.  Setup information can then be shared with others using the “Export Setup” link.  

The recipient of the setup file will use the “Import Setup” link. 

• Choose the Setup tab.   

• Open the Export Setup screen. 

• Select the setup information to export. 

• Choose Export. 

• Name and Save the. avcfg (setup information) file. 

o NOTE:  Use a descriptive name, especially if you save only part(s) of the setup 

information. 

o NOTE:  Either save to a shared location for others to access or save locally and email a 

copy to other users with instructions to save to a local drive for import. 

 

 

Recipients of the Setup Information file(s): 

• Choose the Setup tab. 

• Select Import Setup. 

• Locate the. avcfg file – shared drive or locally. 

• Open the file. 

• Select Import. 
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Create a New Client 
As an eForms Wizard user, working in Client Files and Folders is where you will spend the bulk of your 

time.  To get started with a new client folder: 

• From the File tab, select New Client. 

• Select Personal or Commercial. (Note:  the default is Personal) 

• Enter Client Information fields. 

• You can either Choose a Package and Create, or simply choose Create.  

o NOTE:  If you choose Create, in the next screen you will be prompted to select a form. 

o DEFINITION: A Package is group of previously selected forms (ACORD/Non-ACORD) that 

have been combined based on industry/niche markets or coverages. In the GOLD 

Subscription, the system comes with several packages included; more can be created, 

edited and/or shared with users. (see the section Create Custom Packages for your 

Agency in this Getting Started Guide)  

• Name your Client Folder. 

o TIP:  Consider your current file naming conventions.  You may wish to establish a 

standard naming convention for your eForms Wizard client folders, too.  The default is 

the Client Name YEAR-MO. Another suggestion is:  Client Name  EFF YEAR/EXP YEAR 

(term of the policy/account (2020/2021) 

• Choose Create. 
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Select Forms to Add to the Client Folder (submission) 
If a Package of forms was not selected as you set up your new client, you will be prompted to “Select 

Form”.  The Select Form link (hyperlink or icon), opens the eForms Wizard Forms Library.  You can select 

forms using various Filters: 

• Distributor – these are forms providers – carriers, MGAs, wholesalers, ACORD, etc. 

• Type of Form – i.e. Personal, Commercial, Bond, Specialty 

• Line of Business – i.e. Aviation, Business Auto, Crime, Cyber  

• State/Region  

• “search term” – like a Google search for terms 

Select all the form(s) you wish to pull into the Client Folder by using the “Selected” check box and 

choose Open. 

• NOTE:  You can add additional forms to the client folder at any time using the same process.  

You can also choose to add a group of forms (“package”) at any time by selecting the Packages 

tab and Open Package. 
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Create Custom Packages for your Agency  
A powerful feature of eForms Wizard is the ability to create custom forms packages for your 

organization.  Packages can be created based on niche markets, cross-sell and account rounding 

initiatives, and other sales focused objectives.  Once Packages are created, they can be Shared with 

others which builds more consistent adoption and use. 

• From the Packages tab, select New Package. 

• Name the Package. 

o TIP:  You may wish to establish a standard naming convention for your eForms Wizard 

Packages.  For example:  Restaurants – Fine Dining_New York; Restaurants – Fast Food 

Franchise.   

• Select LOB Type:  Personal or Commercial. 

• Create. 

• The Forms Library will open. 

• Select all the form(s) you wish to include in the Package by using the “Selected” check box and 

choose Save. 

o NOTE:  You can add additional forms to a Package later by choosing “Edit Package”.   

•  Share Package with producers using the “Share Package” icon. 

o Select the Package(s) you wish to share. 

o Choose “+Share” button. 

o Your Outlook email should automatically open with the Package automatically attached 

to a default email containing instructions for the Recipient of this Package. 
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Save as/Export or Share your Submission 
From eForms Wizard, you can easily send your submission to market or share it with a team member to 

complete the submission process.   

You may choose to Share the Current Form (the one currently in your display), Selected Forms (these are 

indicated with a check mark in the top right of each form tab) or All Forms as either a PDF or an AVYST 

Client Folder (.avyx). 

Share 
• From the File tab, select the Share icon. 

• Choose what you wish to share and how. 

o Current Form as PDF. 

o Current Form as AVYST Client Folder. 

o All Client Forms as PDF. 

o All Client Forms as AVYST Client Folder. 

o Selected Forms as PDF. 

o Selected Forms as AVYST Client Folder. 

• You will be prompted to add a password for your PDF or AVYST Client Folder. 

o NOTE:  You will need to provide the password to the Receiver of the PDF / AVYST Client 

Folder under separate cover. 

▪ You can opt out of creating a password by leaving these 2 fields blank, but it is 

strongly recommended that you take advantage of this vital security feature. 

o TIP:  The AVYST Client Folder format is ideal for sharing information with another 

eForms Wizard user (i.e. teammate, wholesaler) in an editable format so they can 

continue adding information before the submission is packaged to go to market. 

• Select Send. 

• You will receive a second data security reminder.  Respond Yes or No. 

• Your Outlook email will automatically open with the PDF / AVYST Client Folder containing the 

form(s) automatically attached. 

• Address your email. 

• Update the Subject Line as desired. 

• And a cover note / narrative. 

o TIP:  Consider using Signature blocks to create standard copy to insert into your email.  

This helps to minimize typing the same text multiple times. 

• Attach any additional external files/documents which may be needed 

• Send. 

o TIP:  A copy of the PDF / AVYST Client Folder can be cc’d to another member of the team 

for information or tracking; and can be attached to a client folder in a management or 

document management system. 

Save as/Export / Create a Copy 
This option is ideal for intentionally saving specific files to a file location – local, shared, cloud.  Often, a 

submission is too large for the “Share” feature as outlined above to work properly with email box or size 

limits.  The Save as/Export feature works very much the same way except the file is saved to a location 

that can then be shared via a secure link. 
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Also, the drop-down menu presents you with the opportunity to Create a Copy of the Client Folder.  This 

is useful when renewing or remarketing an account; you will have the option to change the name/term 

of the client file during this process as well. 

 

 

 

Import Client Folder 
eForms Wizard users will use this feature to open Client Folders shared by other eForms Wizard users.  

The recipient of the shared Client Folder will Save the folder to a local or shared drive location.  If the 

recipient is aware of the file location already, they will simply need to navigate to the correct location as 

part of the import process. 

• Under the File tab, select Import Client Folder. 

• File Explorer opens. 

• Navigate to and Select the desired Client File. 

• Open. 

• If the file already exists, you will be prompted to Overwrite or Create a New Name. 

• Create. 

Printing to Paper or eSignature Solution 
The Print icon in eForms Wizard connects to your existing print drivers.  You can choose to print Current 

Form, All Forms or Selected Forms to paper.  Most eSignature solutions work as a print driver, so you 

can also use your existing solution seamlessly with eForms Wizard.  

 REMINDER:  Under Setup > Configure Options > Colors, you can select Blue or Black ink color. 
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Navigation Tips 
 

• Use the “Tab” key to move through form fields. 

 

• You can Exit/Close eForms Wizard by clicking the “X” in the top right-hand corner of the 

program or you can choose “Save & Exit”.  Either will save your work before the program closes. 

eForms Wizard continuously saves as you are working. When you open eForms Wizard again, it 

will take you to where you left off. 

 

• To switch between forms within a Client Folder use the “hamburger” icon in the top, left corner 

of the form. 

 

This icon provides forms functionality, including: 

o Print 

o Switch 

o Zoom 

o Clear 

o Remove 

 

• To lock a form, use the lock icon in the top, left corner of the form.  

 

• Change Agency / Carrier / Producer information 

o   Use the “arrow” icon to open the appropriate list and make a new selection 

 

• Use the “back arrow” to return to your place in a client folder / form. 

 

• eForms Wizard Updates:  Approximately every 45 days on average, there are updates to your 

eForms Wizard program. When you open eForms Wizard it automatically checks for updates. If 

there is an update available, you will see the prompt “Update Now”.  You can choose to go on 

working without doing the update. Or you can choose to “Update Now”. This automated 

updated process typically takes 5-10 minutes.  When the update is complete, eForms Wizard will 

launch and you will return to where you left off on your last visit.  We encourage you to stay as 

current as possible so you can take full advantage of updated features, functionality and any 

added forms. Getting too far out of date, can create license verification issues. 
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Corrections/Updates to Client Folder Information 
To make a correction to Client Information entered during the initial setup of a Client, select the Recent 

Client List dropdown - top left of the screen. 

• Select Edit Client Folder. 

• Make edits. 

• Save. 

 

 

 

 

 

 

 

 

 

 

Edits to Data Fields / Adding or Changing Information in Form Fields 
When data entered into a field that is mapped to other fields on forms included in the Client Folder is 

edited, a drop-down menu of options will appear to ask how the edits should be applied.  See the screen 

shot below.  Be sure to make the appropriate selection, otherwise the data edit will only appear in the 

current form field and will not flow to other forms as expected. 
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Getting Started Checklist 
 

To Do eForms Wizard Feature to Master 

□ Download and Install eForms Wizard using the instructions HERE or in the Welcome 
Email received from AVYST 

□ Launch eForms Wizard from your computer/tablet  

□ Set up your Agency / Agency Branch Offices 

□ Set up Producers and assign them to the appropriate Office 

□ Set up your Carrier NAIC codes 

□ Configure Options 

□ Share / Export Setup with Others OR Import if you are the recipient of the setup file 

□ Create a new client 

□ Select a default package for use with the new client 

□ Search/select additional forms to add to the client submission 

□ Save your Submission (locally, shared drive) 

□ Share your Submission (all or selected forms) as a password protected PDF 

□ Share the entire Submission as an AVYST Client Folder (fillable) 

□ 
Create Packages for your Agency based on niche markets and Share/Export with 
your Producers.  (Others will Import the Package file to their eForms Wizard) 

 

Additional Resources: 
• To Purchase eForms Wizard, visit our Pricing & Subscription Details which includes links to our 

various partner order forms.  Retail Pricing:  GOLD (full functionality – best for Producers & 

Account Managers) - $100/user/year; BRONZE (limited functionality – best for Administrative 

Staff) - $50/user/year 

• Short Videos on various eForms Wizard Features on our Training & Resources webpage 

o Agency & Producer Setup 

o Working with New and Existing Clients 

o Save As, Share and Import a Client Folder 

o Create & Share Custom Packages 

o Printing 

• Additional Questions – email info@avyst.com or call 877-204-0704 (option 2) 

• Submit Forms to add to eForms Library – email them to kitty@avyst.com 

• To Submit Enhancement Ideas please click on this link:  https://avyst.com/support/ and click on 

the “Let us know your great idea” “button” to fill in the form.  Thank you – we encourage your 

input for enhancement ideas! 
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